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Greetings Harrisburg Chapter Members – 
 
While my recollection of  the month of  February usually includes snow, 
cold and dreary days, and even boredom, this February has become the 
exception. 
 
It hasn’t been too cold, we haven’t had much snow, and boredom has 
been non-existent.  I personally have been extremely busy at work and 
with my IAAP responsibilities.  I, along with Harrisburg Chapter Mem-
bers, Nancy Deibler, CAP-OM and Helen Wallace, CAP-OM had an 
opportunity to speak with HACC students.  We spoke about our work 
experience and how our involvement with IAAP influences our profes-
sional roles.  I also had the opportunity to facilitate a certification re-
view class and meet some great ladies. 
 
I know many others are busy as well.  The Administrative Professionals 
Day/Week Committee is busy finalizing all the details for their event in 
April and the Seminar Committee has things well underway for their 
event in May.  Find out what else is going on in this edition of  Sketches. 
 
Until next month, when we spring forward, continue to make your 
leaps to become remarkable! 
 

Jena 
Jena Creter, CAP-OM, President 
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4 IAAP Spring Conference 

12  Board Meeting 

19 Harrisburg Chapter Membership Meeting 

 

23 
APD Event /  
Harrisburg Membership Meeting 

  

14 Board Meeting 

19 Highmark Walk 

21 Harrisburg Chapter Membership Meeting 

8 Seminar 

 
2012 Pennsylvania  

Division Annual Meeting 
  

SAVE THE DATE 
   

June 22–24, 2012 
Holiday Inn Conference Center 

7736 Adrienne Drive 
Breinigsville, PA 18031 

Hosted by Lehigh Valley Chapter 
 Allentown, Pennsylvania 
and surrounding areas  

 
Be on the look out for more 

information!!!! 

  

 

 

What's happening in other Divisions  

in the Northeast District? 

 

Visit their websites by clicking the following links: 

 

New Jersey Division 

www.iaap-njd.org  

 

New York Division 

www.iaap-newyorkdivision.org 

 

Greater New England Division    

www.iaap-gned.org 
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Vicki Matteson, CAP                          5 yearsVicki Matteson, CAP                          5 yearsVicki Matteson, CAP                          5 yearsVicki Matteson, CAP                          5 years    

    

    

    

    

March 6                Candace White, CAPMarch 6                Candace White, CAPMarch 6                Candace White, CAPMarch 6                Candace White, CAP----OMOMOMOM    

March 16March 16March 16March 16                      Jodi Mattern. CAP                  Jodi Mattern. CAP                  Jodi Mattern. CAP                  Jodi Mattern. CAP    

March 18                                        Arla NeitzMarch 18                                        Arla NeitzMarch 18                                        Arla NeitzMarch 18                                        Arla Neitz    

March 24               Sandra Moritz, CAPMarch 24               Sandra Moritz, CAPMarch 24               Sandra Moritz, CAPMarch 24               Sandra Moritz, CAP----OMOMOMOM    

March 25                      Dawn Hall, CAPMarch 25                      Dawn Hall, CAPMarch 25                      Dawn Hall, CAPMarch 25                      Dawn Hall, CAP----OMOMOMOM
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I’m sure you all know that 2012 is a leap year. Everyone gets one extra day this year. How are you going to 

use it? We’re always asking for more hours in a day. Getting an extra day is the next best thing. Here’s a 

small fact for you: Did you know that any year that’s not a leap year is called a common year? I find it fitting 

that the 2011-2012 board theme this year is Making the Leap to Remarkable. Let’s all decide today to move 

beyond the “common year” and make this a year to remember—a year to be remarkable.  

We can band together in Making the Leap to Remarkable by getting enthused and committed to the 70/70 

Membership Campaign. During our 70th anniversary year, new professional members can sign up for IAAP 

membership at the international, chapter and division level all for only $70. That’s only if the chapter and 

division they want to join choose to participate.  

By chapters and divisions banding together, signing up and committing to be a part of this, we can grow our 

membership! Members are what make IAAP a great association. And IAAP is what makes great admins. 

Share this message with each of your members. Encourage each of them to bring new members into the as-

sociation. More members equal strong chapters and divisions. We’ve compiled a 70/70 FAQ from questions 

the board is getting on the new program. We’ve also created a 70/70 flyer you can give to members to get 

them excited about the program. These are located in the web community. You will have to log in to view 

them. 

If you haven’t already heard, we’re extending the early bird registration rate for Spring Conference until reg-

istration is full. Those who want to sign up can only get the early bird extension through a special link. Share 

this with your members and your co-workers: http://community.iaap-hq.org/misc/springconf/ I’m excited 

about all I’m going to learn at Spring Conference. Did you know Gini Courter is giving a tech session on Sun-

day? I always learn something new I can apply to my job during one of her sessions. I hope to see you there.  

It’s time to sign up to get certified. Please remind your members that the deadline for registering for the cer-

tification exam or the Organizational Management specialty is Feb. 15. Don’t let that deadline pass by.  

The 2012 EFAM is months away but I know that many of you are trying to make plans and adjust your sched-

ules for the most exciting and educational week of the year. There are a few changes for 2012 and we 

wanted to make sure you had that information as soon as we nailed everything down. Here’s an EFAM 2012 

early schedule sheet with a very general breakdown of all the times you’ll need for flights in, flights out and 

hotel rooms.  

Thank you for how hard you work for the good of the association and to benefit your members. This month 

we’re debuting something we hope will help you do your job better. The staff at headquarters has created a 

Marketing Toolbox. Each month, about mid-month, leaders will get a short “toolbox” of two or three market-

ing pieces you can share with your members. Better yet, included are helpful instructions on how you can to 

use the pieces. Watch for it in your inbox next week. That’s about it for this month. Thanks again for all your 

hard work and dedication. I appreciate all the extra time you put in to make this association great.  

Tamra Goodall, CAP-OM 

International President  
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In celebration of  IAAP reaching its 70th anniversary, we’re offering administrative 

professionals a special price when they join the association as a new member. From 

now until December 31, 2012, new members can join IAAP at the chapter, division 

and international level—all for one $70 price. Don’t put it off. Join today to take ad-

vantage of  the world’s best networking and education for administrative professionals. 

 

 

 

               http://www.iaap-hq.org/join 

The 2012 Highmark Walk for a Healthy Community Harrisburg will be held Saturday, 

May 19, 2012.  Harrisburg Chapter IAAP had the “A Team” walking in 2011.  Please think 

about joining us again on this fantastic walking adventure.  The walk will take place at 

HACC this year.  This year’s walk benefits 41 local health and human service organiza-

tions.   

The APW Committee has secured Hershey Lodge to 

host the Annual APW event.   The entertainer chosen 

for this event is Robert Priest, Mind Reader.   The 

Theater of  The Mind is a thought provoking enter-

tainment event for structured groups.  Working for maximum audience participation, 

Robert Priest uses the thoughts of  audience members to make them the stars of  the show.  

Audiences are amazed as he seems to pull words and thoughts from their minds.  Pre-

sented with a professional polish and spontaneous wit.  Prepare yourself  to be dazzled!  

Visit his webpage at http://www.robertpriest.com 
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Announcement  -  Brenda Dersham, IT Senior Business Analyst, Hershey Entertainment and Resorts, 

who has  been a facilitator for our CAP® review class has been appointed to be an  exam proctor for our 

chapter area.  Many of you know we lost our exam proctor from HACC when  Alyse Shaffer retired. This 

appointment comes at a great time, because our current certification class was planning to travel to Kap-

lan University, Hagerstown MD for the May Exam.  We hope by having a proctor in our area again, it will 

encourage more participation from the surrounding chapters and especially from our chapter.   

 

Deadline - May 5th Certification Exam was February 15th.  Late registrations are still available.    

 

The current Certification Review Class has 7 members (2 are chapter members) and 6 of the 7  will sit 

for both the CAP and OM exam.   

 

Remember we’re putting together a goodie bag for the 7 participants and would appreciate any item 

you can donate:  chocolate, crackers, pretzels, pencils, hand sanitizer, tissues or any other goodie to sup-

port the group.  Please contact Nancy Deibler, ndeibler@presbyterianseniorliving.org  with any ques-

tions.   
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JOANNE M. DICKEY 
1937 – 2012 

Joanne Dickey was a long time devoted member of the Harrisburg 
Chapter. 
 

When she joined the association, it was known as NSA (National Secre-
taries Association).  Proud of her title of “secretary” in the workplace, she weathered the controversy 
of a name change to PSI (Professional Secretaries International), and later, to IAAP. 
 

Joanne joined the Harrisburg Chapter in December 1973.  In “those days” it was required that you be 
sponsored by another member, and that your boss sign the application. 
 

Joanne was always an active member, serving on or chairing almost all chapter committees.  She also 
served on a number of special committees, including the 50th Anniversary, and the 2000 and 2006 PA 
Division Annual Meeting Committees.  She served as parliamentary advisor to a number of chapter 
presidents, who fondly remember her stern hand over the board and membership meetings. 
 

During the 1977 – 78 chapter year, Joanne served as chapter president, culminating her journey 
through the chapter offices. 
 

In 1984, Joanne joined the PA Division Board as secretary.  She progressed through the offices, serv-
ing as PA Division President in 1986 – 87. 
 

Many members remember Joanne as the secretary to Reverend Robert F. Matthias, Pastor of Messiah 
Lutheran Church in Harrisburg.  Prior to that, Joanne was secretary to Keith Leuschner, Acting Direc-
tor of the Office of Fiscal Management, Commonwealth of Pennsylvania.  She was also secretary to C. 
Charles Erb, Director of the Office of Fiscal Management, Department of Public Welfare.  Joanne 
worked for the Department of Education prior to joining the Department of Public Welfare. 
 

Joanne was a quiet, private person.  Those who had the opportunity to travel with her to various NSA/
PSI/IAAP events and to work with her on committees were fortunate enough to get to know her and 
call her friend. 
 

She was a friend, a leader and a mentor to many of us. 
 

We’ll miss you, Joanne. 
 

Joanne’s minister, Rev. Suanne Whorl of Charlton United Methodist Church, shared these thoughts 
about Joanne: 
 
She was a lady of refinement, of integrity, of professionalism and style.  She dressed nicely, was 
fiercely independent, and could make you laugh with her quiet wit.  She found things to fill her life and 
shower her love on – she loved the Phillies, the Eagles and Penn State.  She loved to read and she 
loved being a part of the International Association of Administrative Professionals.  She loved Danc-
ing with the Stars, and … I understand she would call her friend Vida every week…to speculate about 
who was going home.                                                                                                                               .                                                                                                                               .                                                                                                                               .                                                                                                                                                                                                                   ————Tribute submitted by Kathie HookTribute submitted by Kathie HookTribute submitted by Kathie HookTribute submitted by Kathie Hook    
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Can you believe we are already in February?  Wow, has the first month flown by.  I hope you enjoy 
this edition of sketches.  Special thanks to Kathie Hook for her article on Joanne Dickey.   
 
Please have articles for March Sketches submitted to me by March 12, 2012.  Articles may be 
emailed to me at wsnavely@hersheypa.com. 
 
Note:  If anyone would like a copy of Bob Wallace's presentation in January, please email Helen 
Wallace at  hewallac@hacc.edu 

Everybody knows Microsoft Word. It’s on almost every PC in the 
world and a fair few Macs as well. However, a lot of users have 
picked up bad habits, things that detract from the usefulness of the 
document being created. This article looks at the most common basic 
errors among Microsoft users. 
 

• Are you ever guilty of pressing the Return key at the top of a document to move the cursor down, perhaps 
when creating a document to be printed on your company stationery? If so, this means that you are creating a 
document with unwanted characters at the start. Much better to click on File – Page Setup and change the top 
margin (in Word 2003) or click on Custom Margins in the Page Layout tab of the Word 2007 ribbon. 

 

• Leaving two spaces after the period which ends each sentence is another common error among users. In fact, 
one space is fine with modern typefaces since they are proportionally spaced (e.g., the letter “w” takes up more 
space than the letter “i”). The two space habit is a throwback to the days when people were using typewriters 
with monospace typefaces such as Elite and Courier. 

 

• The habit of pressing the Return key twice at the end of each paragraph is not a good idea because it creates a 
sea of extra white space on the printed page. Only one return should used to end the paragraph. Extra space 
can then be added using the paragraph spacing commands. To find these options, in Word 2003 or earlier, 
choose Paragraph from the format menu. In Word 2007, click on the Page Layout tab. 

 

• If a casual user of Word has never had any training, you will often see him or her using the space bar to align 
columns of text. This sometimes looks as though it’s working on screen but when the document is printed, the 
lack of alignment becomes very apparent. The only sure way of getting columns to align is to press the Tab 
key. 

 

• Having identified the Tab key as the correct one to use to create columns, many Word users just press the tab 
key to tab along to the next default tab. The number of times the Tab key is pressed will thus vary, depending 
on the length of each piece of text. It is much better to set one’s own tabs by clicking on the Word ruler. This 
means that on each line of text, the tab key will be pressed the same number of times between columns. 

 

• Another common mistake among Word users is to manually format text in long documents or perhaps to user 
the Format Painter. Manually formatting text is fine for single page or short documents but with long docu-

ments, it’s best to use Word’s style feature. That way, if you need to modify the appearance of the document, 
all you need to do is to modify the attributes of the styles. 

 

• Word has a number of AutoCorrect options which can seem intrusive to new users and who complain 
about them without attempting to switch them off. To modify Word’s AutoCorrect and other settings, 
choose Options from the Tools menu (Word 2003/2002 etc.) or choose Word Options from the Of-
fice button in Word 2007. 
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